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Welcome to Sprint

nly Sprint built the largest all-digital, all-PCS nationwide network with 
advanced multimedia services, reaching more than 230 million people 

for clarity you can see and hear.

When it comes to mobile connectivity, the PCS Connection CardTM offers 
more freedom than ever before. No wires, no cables, just access to your data 
when you need it. The power of the Internet and company data is truly at 
your fingertips.

This guide will familiarize you with our technology and your new 
PCS Connection Card and the Wireless Connection Manager Software 
through simple, easy-to-follow instructions. If you have already reviewed the 
Getting Started Guide, which was packaged with your PCS Connection Card, 
then you're ready to explore the advanced features outlined in this guide. 

If you have not read your Getting Started Guide, go to Section One - Getting 
Started With Your PCS Connection Card (page 5). This section provides all 
the information you need to install the Wireless Connection Manager 
Software, activate your PCS Connection Card and much more. It also 
contains information on how to contact Sprint should you have questions 
about service, want to purchase additional products or services, or just to 
check your account balance.

Thank you for choosing Sprint.

O
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Introduction to this User’s Guide

his User’s Guide introduces you to the PCS Connection Card and 
Wireless Connection Manager Software through easy-to-follow 

instructions.

We know your time is valuable and that is why we have designed this guide 
to be used in a building block format or in stand-alone sections. You will get 
the most out of your card and software if you read each section. However, if 
you’d like to get right to a specific feature, simply go to that section. 
Follow the instructions in that section and you'll be ready to use your card in 
no time.

If you require additional information or help, visit www.sprintpcs.com or 
call PCS Customer Service SolutionsSM at 1-888-211-4PCS (4727).

Tip: You can print out this guide to keep on hand or view it online. If you're 
viewing it online, simply click on a topic in the Table of Contents or on any 
page reference within a section to go directly to that topic.

T

http://www.sprintpcs.com
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Sect ion 1

Getting Started With Your 
PCS Connection CardTM

In This Section

� Your PCS Connection CardTM

� PCS Connection Card Components

� System Requirements

� Care and Maintenance of Your PCS Connection Card

� Installing the Wireless Connection Manager Software

� Inserting and Removing Your PCS Connection Card

� Activating Your PCS Connection Card

his section walks you through the basics of getting started 
with your new PCS Connection Card, including installing the 

Wireless Connection Manager Software and inserting and activating 
your card.

T
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Your PCS Connection Card
The PCS Connection Card utilizes CDMA technology enabling real-time 
wireless access to email, the Internet or your company network. The card 
runs on most current Windows-compatible laptop or desktop computers, 
and it provides data transmission of up to 144 kilobytes per second (kbps). 
The PCS Connection Card also runs on Pocket PC 2000 and Pocket PC 
2002. Windows 98 (SR2/SE), 2000, ME or XP, as well as a type II PC card 
(PCMCIA) slot are also required.

The Wireless Connection Manager Software allows you to monitor and 
control the operations of your card and it also provides you with limited 
diagnostic information for troubleshooting any difficulties you may 
encounter.

PCS Connection Card Components
All PCS Connection Card packages include the following components:
� PCS Connection Card
� Storage case for your card
� Getting Started Guide
� CD-ROM containing the Wireless Connection Manager Software, 

PCS Business ConnectionSM Web link and an electronic copy of the 
User’s Guide

Getting Started
Before you can use your PCS Connection Card, you must first:
1. Install the Wireless Connection Manager Software, located on the 

Installation CD, onto your computer.

Note: Before installing your new software, delete or uninstall any 
previously existing modem or dialer software from your system.

Note: Do not insert the PCS Connection Card in the slot until prompted to 
do so by the Setup program.

2. Insert the card into your computer’s PC card slot (Sprint label 
facing up). Windows will detect the card and automatically install 
the necessary card drivers.
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3. Launch the Wireless Connection Manager Software application.
4. If your card has not previously been activated, the Activation Wizard 

will automatically launch and guide you through the process.

System Requirements
The following items are required in order to properly run the 
PCS Connection Card and accompanying software:
� Pentium 90 (or higher) processor
� Windows 98 (SR2), 2000, ME or XP
� 32 MB RAM (for Windows 98 and ME), or 

64 MB RAM (for Windows 2000 and XP)
� 16 MB available hard drive space
� CD-ROM drive
� Type II PC card slot (PCMCIA)

Care and Maintenance
As with any electronic device, the PCS Connection Card should be 
handled with care. Follow these guidelines when using or storing 
your card:
� Avoid storing the card in places of extreme heat or cold.
� Do not immerse the card in water.
� Do not apply labels or decals to the top or bottom of the card, as this 

may cause the card to become jammed in the PC card slot.
� Keep the card in a dry, clean space.
� Never force the card into or out of your computer’s PC card slot.
� When moving your computer, always remove the card from the PC 

card slot to avoid damage.

Managing Your PCS Account
For information about your PCS Account or to change your User name 
and password, visit www.sprintpcs.com or call PCS Customer Service 
Solutions at 1-888-211-4PCS (4727).

http://www.sprintpcs.com
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Installing the Wireless Connection 
Manager Software

This section guides you step-by-step through the Wireless Connection 
Manager Software installation procedure.

Once you complete the installation process and activate your 
PCS Connection Card, you will be able to use your card with your 
Internet applications.

If you require help at any time during the installation process, please 
contact PCS Customer Service Solutions at 1-888-211-4PCS (4727).

Windows 98 SE, ME, 2000 and XP Installation Process

To install the Wireless Connection Manager Software:
1. Insert the Installation CD into your computer’s CD-ROM drive. 

The installation program will automatically run.
2. Follow the instructions displayed onscreen to begin installing the 

Wireless Connection Manager Software. The Welcome window will 
appear (see Figure 1).

Figure 1: Welcome window
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3. Read the information displayed onscreen and click Next to 
continue. The License Agreement window will appear 
(see Figure 2).

Figure 2: License Agreement window

4. Read the agreement and select I read and agree to the above 
terms if you are satisfied with the agreement.

5. Click Next to continue. The Start Copying Files window will appear 
(see Figure 3).

Figure 3: Start Copying Files window
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6. If you are satisfied with the installation settings, click Next to 
continue. A message will appear (see Figure 4) allowing you to 
specify whether you want an icon for the Wireless Connection 
Manager placed on your desktop.

Figure 4: Desktop Icon message

7. Click Yes to create a desktop icon for the Wireless Connection 
Manager or No if you would not like a desktop icon. The 
Installation Complete window will appear (see Figure 5).

Figure 5: Installation Complete window
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8. Click Finish to exit the Installation program. The Install window 
will appear (see Figure 6).

Figure 6: Install window

9. You are required to restart your computer in order to complete the 
Wireless Connection Manager Software installation procedure. Click 
OK to reboot your computer.

10. Once your computer has rebooted, insert the PCS Connection Card 
into your computer’s PC card slot (see “Inserting and Removing 
Your PCS Connection Card” on page 12 for more information). 
Windows will detect the new hardware and will install the necessary 
drivers. The Found New Hardware window or Found New 
Hardware Wizard will appear, depending on your operating system 
(see Figure 7).

Figure 7: Found New Hardware window

Note: If the message “Digital signature not found” appears, you will need 
to click Yes to properly install the hardware driver. When installing to 
Windows 2000 or Windows XP, the message will appear three times; click 
Yes each time to properly install the driver.
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Inserting and Removing Your 
PCS Connection Card

Before you insert the PCS Connection Card, you must first install the 
Wireless Connection Manager Software. Once you have completed the 
installation procedure, you may insert your card into your computer’s PC 
card slot. The Sprint label should be facing up, and the 68-pin connector, 
located at the end of the card, should be inserted directly into the 
computer’s PC card slot.

Note: The PCS Connection Card should fit snugly, but you should be able to 
insert or remove it easily from your computer’s PC card slot.

A portion (the black section) of the card will remain outside the 
computer’s PC card slot. This section contains the card’s antenna and the 
LED (light emitting diode). Because the card is not entirely contained in 
your computer’s PC card slot, it is important to remove the card when 
transporting your laptop or notebook.

To remove your card, you must first stop the card using the PC card tray 
icon , located in the bottom-right corner of your desktop. Click the 
icon and select Stop from the dialog box.

Once your card has been stopped, press the PC card eject button, located 
on your computer, and remove the card completely from the PC card slot.
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Activating Your PCS Connection Card
To launch the Wireless Connection Manager, double-click the shortcut 
icon placed on your desktop, or select Start Programs Novatel 
Wireless Wireless Connection Manager.

If your card was not previously activated, once the Wireless Connection 
Manager application opens, the Sprint Activation Wizard will 
automatically launch (if your card has been pre-activated, you will not 
see the Activation Wizard).

The Sprint Welcome window will appear (see Figure 8).

Figure 8: PCS Connection Card Activation (window 1)
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1. Click Next to begin the activation process. The PCS Connection Card 
Activation window will describe the activation process (see Figure 9).

Figure 9: PCS Connection Card Activation (window 2)

2. Please telephone PCS Customer Service Solutions to set up your 
PCS wireless network account.
� If you will be using your PCS Connection Card primarily for 

business purposes, call 1-877-789-3969.
� If your card is intended primarily for personal use, 

call 1-888-715-4588.

You should have the following information available:
� Your billing address
� Your Social Security or Tax ID number
� Your driver’s license number
� A pen and paper to write down your account information

During this call, PCS Customer Service Solutions will help you select 
your service plan and guide you through the activation process.
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3. Click Next when you are asked for your card’s Electronic Serial 
Number (ESN). The third PCS Connection Card Activation window 
will appear, which displays your card’s ESN in the top field (see 
Figure 10).

Figure 10: PCS Connection Card Activation (window 3)

4. Carefully repeat the Electronic Serial Number to the 
Service Representative. You will then be given an activation code.

5. Enter the activation code into the bottom field of the 
PCS Connection Card Activation window.

6. Click Next to continue. The next window will appear (see Figure 11).

Figure 11: PCS Connection Card Activation (window 4)
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7. Once you have been given your card’s phone number, enter the 
number in the top field, as shown in Figure 11.

8. Re-enter the phone number in the bottom field for activation, and 
click Next to continue.

Note: If the phone numbers you entered in the two fields do not match, a 
warning will appear requesting that you verify that the phone numbers 
entered are correct.

You have now successfully completed the activation process. Your 
phone number and lock code will be displayed at the bottom of the 
final PCS Connection Card Activation window (see Figure 12).

 

Figure 12: PCS Connection Card Activation (window 5)

9. Click Finish to exit the Sprint Activation Wizard.

You may now use the Wireless Connection Manager with your Internet 
applications. See Section 2: The Wireless Connection Manager on 
page 17 for more information.
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Sect ion 2

The Wireless Connection Manager

In This Section

� Wireless Connection Manager Main Window

� Controlling the Wireless Connection Manager

� System Tray Icons

� Using the Web Messaging Feature

� Using the Optimized RAS Option

� PCS Connection Card Configuration Window

� PCS Connection Card Configuration Settings

� PCS Connection Card Properties Window

� Detailed Status Reports Window

� About Wireless Connection Manager Window

he Wireless Connection Manager application allows you to monitor 
and control the operation of your PCS Connection Card. This section 

describes the functions of the various fields and windows contained in the 
Wireless Connection Manager application. 

T
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Wireless Connection Manager Main Window
When you launch the Wireless Connection Manager application, the 
main window will open (see Figure 13).

Figure 13: Wireless Connection Manager main window

The main window consists of the following items:

Duration This field indicates the length of time connected.

Total Bytes Sent This field indicates the amount of data (bytes) the card 

has sent during the current network session.

Total Bytes Received This field indicates the amount of data (bytes) the card 

has received during the current network session.

Connect or 
Disconnect Button

This button allows you to Connect or Disconnect from the 

network, depending on the current state of the card. If the 

card is locked when attempting to connect, you will be 

prompted to unlock it before connecting.

Signal Strength 
Status Bar

This display indicates the card’s signal strength. If 

adequate signal strength is present, several of the five bars 

will be shaded green. The greater number of bars filled, the 

stronger the signal strength.
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Controlling the Wireless Connection Manager

Connecting to the Network
To connect to the network, click Connect from the main window 
(see Figure 14). The card will attempt to register to the network using the 
information provided in the default connection profile. 

A connection profile provides Sprint with the necessary information to 
identify your card and access your network account.

Figure 14: Wireless Connection Manager main window

Sprint URL Clicking http://www.sprintpcs.com will take you directly to 

the PCS Web page when connected.

PCS Connection Card 
Status

This status indicator, located at the bottom of the main 

window, displays the card’s network connection status.

Mail Icon  Clicking this button will open the Web Messaging 

window, which allows you to view any messages you 

have received.

Lock Icon
 This button allows you to lock or unlock your card.

http://www.sprintpcs.com
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Controlling Compression
In order to optimize the connection speed and enhance your wireless 
experience, data has been compressed. You may turn off compression by 
selecting Compression from the File menu (see Figure 15).

Figure 15: Compression Option window

When data is being compressed, the compression icon  will appear in 
the main window under Signal Strength (see Figure 16).

Figure 16: Compression Active
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Disconnecting From the Network
To disconnect from the network, click Disconnect from the main 
window (see Figure 17).

Figure 17: Wireless Connection Manager main window

Quitting the Wireless Connection Manager Application
To quit the Wireless Connection Manager application, click the  
located in the top-right corner of the main window or select Exit from 
the File menu (see Figure 18). The PCS Connection Card will terminate 
its network connection, and the Wireless Connection Manager 
application will shut down.

Figure 18: Exit command
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Showing and Hiding the Wireless Connection Manager

Keeping the Wireless Connection Manager Window Always 
Visible

To keep the Wireless Connection Manager window on top of all other 
open windows, select Always on Top from the Window menu 
(see Figure 19).

Figure 19: Always on Top command

Once this menu item is selected (indicated by a check mark next to the 
item), the Wireless Connection Manager window will remain on top of 
all other windows. 

Note: Click Always on Top a second time to disable this command. The 
check mark will disappear and the Wireless Connection Manager window 
will no longer remain on top of all other open windows.
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Hiding the Wireless Connection Manager Task Bar

To hide the Wireless Connection Manager task bar when you minimize 
the screen, select Hide When Minimized from the Window menu 
(see Figure 20).

Figure 20: Hide When Minimized command

To re-open the Wireless Connection Manager window, double click the 
system tray icon , located in the bottom-right corner of your desktop. 
You may also right-click on the system tray icon and select “Open 
Wireless Connection Manager.” (For more information on system tray 
icons, see “System Tray Icons” on page 28.)
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Total Bytes Fields
The Total Bytes fields are displayed in the main window (see Figure 21) 
and in the General tab of the Detailed Status Report window (see 
Figure 22). The last date the byte totals were cleared is also displayed in 
the General tab. (For further information on the Detailed Status Report 
window, see “Detailed Status Report Window” on page 45.)

Figure 21: Wireless Connection Manager main window

Figure 22: Detailed Status Report window

Important: The data displayed in the Total Bytes fields is for general 
information only and is not intended to be used for billing purposes.
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Clearing the Total Bytes Fields

You may clear the Total Bytes fields by using the Clear Bytes command, 
located under the Tools menu on the main window (see Figure 23).

Figure 23: Clear Bytes command

The date you last cleared the Total Bytes fields is displayed in the General 
tab of the Detailed Status Report window (see Figure 22).
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Locking and Unlocking Your PCS Connection Card

Locking Your PCS Connection Card

The Wireless Connection Manager application contains a lock feature, 
which allows you to temporarily disable your card’s ability to call or 
connect to the network. Once you unlock your card, you may again 
access the network.

To lock your card:
1. Click the Lock button  located in the bottom-right corner of the 

Wireless Connection Manager main window.

The Confirmation window will appear (see Figure 24)

Figure 24: Lock Confirmation window

2. Select Yes to lock the device.
3. You can also access the Device Lock Option by selecting 

Configuration from the File menu to open the 
PCS Connection Card Configuration window (see Figure 25).

Figure 25: PCS Connection Card Configuration window
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Unlocking Your PCS Connection Card

To unlock your card:
1. Click the Lock button , located in the bottom-right corner of the 

Wireless Connection Manager main window.

The Enter Lock Key window will be displayed (see Figure 26).

Figure 26: Enter Lock Key window

2. Enter your lock code into the Enter Code text field, and click OK. 
The default lock code is the last four digits of your card’s phone 
number. (To change your lock code, see “Changing Your Lock Code” 
on page 43.)

Once you have correctly entered your lock code, your card will be unlocked.
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System Tray Icons
A system tray icon will appear in the bottom-right corner of your desktop 
when you launch the Wireless Connection Manager application. The tray 
icon provides easy access to the Wireless Connection Manager’s main 
window and the card’s connection status.

The following icons indicate the card’s connection status:

 - The card is currently connected to the network.

 [flashing] - The card is in the process of connecting to the network.

 - The card is connected to the network but in a dormant state.

 [flashing] - The card is disconnecting from the network.

 - The card is not connected to the network.

If the Wireless Connection Manager window is not visible, double-click 
on the tray icon to open it. (To set the window to always be visible, see 
“Keeping the Wireless Connection Manager Window Always Visible” 
on page 22.)

You can control the operation of the Wireless Connection Manager by 
right-clicking on the tray icon, and selecting an action from the pop-up 
menu (see Figure 27).

Figure 27: Pop-Up menu
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Using the Web Messaging Feature

Viewing a Web Message
The Message button , located in the bottom-right corner of the 
main window, will flash if you have received a new text message.

To view a text message, click the Message button. The Web Messaging 
window will open (see Figure 28).

Figure 28: Web Messaging window

Double-click on the new message to view its contents (unread 
messages are indicated by bold font). The Web Messaging window also 
displays the number from which the message was received 
(the Callback No), and the date the message was received.
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Sending a Web Message
There are three ways to send a Web message:
1. Using your PCS Phone, dial the phone number to which you wish to 

send a message, and leave a numeric message.
2. Using your Web browser: 

� Go to www.messaging.sprintpcs.com.
� Select the Phone tab. 
� Enter the PCS Phone Number to which you wish to send the 

message, the Callback number (the Callback number is a 
7 or 10 digit phone number at which you can be reached), 
and the message, which can be up to 160 characters long 
(including spaces).

� Once you have correctly entered the necessary information, 
click Send.

3. Using your email program:
� Open a new email message.
� Address the email to the 10-digit PCS Phone Number at the 

domain “@messaging.sprintpcs.com”.
� Include a subject if you desire, and compose your message 

(up to 160 characters, including spaces).
� Click Send. 

http://www.messaging.sprintpcs.com
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Deleting a Web Message
To delete a Web message, open the Web Messaging window by clicking on 
the Message button . The Web Messaging window will open.

Figure 29: Web Messaging window

Highlight the message you want to delete, and click the small red  
(see Figure 29). 

To delete all the messages in the Web Messaging window, click the 
large red . 

Using the Optimized RAS Option
Your PCS Connection Card may be used to facilitate an optimized RAS 
(remote access server) connection to your corporate office or other 
services that require a phone number for access.

Installing the PCS Software Modem
Creating a new connection to your dial-up network is simple; however, 
you must first install the PCS Software Modem. If the PCS Software 
modem is already installed, skip to “Adding a New Dial-up Connection” 
on page 37.

If you attempt to add a new connection and the PCS Software modem is 
not installed, you will be prompted to install the modem on your 
computer’s COM port.



Section 2
32 The Wireless Connection Manager

1. A help prompt window will be displayed to indicate that the PCS 
Software modem has not been installed (see Figure 30). Click on the 
hyperlink for instructions on installing the PCS Software modem on 
your computer’s COM port.

Figure 30: PCS Software Modem Install Help

Note: If installing with Windows 98SE, note the COM port number 
displayed in bold in the Help window. It will be used in step 4.

2. Within your computer’s Control Panel, select the Phone and 
Modem Options Utility (see Figure 31). (In Windows 98SE, the 
utility is called Modems.)

Figure 31: Control Panel
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3. For Windows 2000 and XP, select the Modem tab and click Add 
(see Figure 32). Proceed to step 6 (page 34).

Figure 32: Phone and Modem Options (Windows 2000 & XP)

4. For Windows 98SE, click Add under the General tab (see Figure 33).

Figure 33: Modem Properties  (Windows 98SE)
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5. Select Other for “What type of modem do you want to install?” and 
click Next (see Figure 34).

Figure 34: Install New Modem (Windows 98SE)

6. The Add/Remove Hardware Wizard will launch. Select “Don’t detect 
my modem; I will select it from a list” and click Next (see Figure 35).

Figure 35: Add/Remove Hardware Wizard
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7. Select Sprint from the Manufacturers drop-down list. The PCS 
Software Modem automatically appears in the Models text window 
(see Figure 36).

Figure 36: Add/Remove Hardward Wizard

8. Highlight the COM port listed on the modem install help window 
(see Figure 30) and click next (see Figure 37).

Figure 37: Add/Remove Hardware Wizard

IMPORTANT! The modem must be installed on the port identified by the 
PCS Software Modem Install Help window.
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9. A Digital Signature Not Found window will appear. Click Yes to 
disregard the notice and continue with the installation (see 
Figure 38).

Figure 38: Digital Signature Not Found

10. Click Finish to complete the installation (see Figure 39). The PCS 
Software Modem now appears as a Phone and Modem option on 
your computer.

Figure 39: Add/Remove Hardware Wizard
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Adding a New Dial-up Connection
Adding a new dial-up connection in the PCS Wireless Connection 
Manager is very similar to adding a dial-up connection on your 
computer. A New Connection Wizard will guide you through the process.

To configure your RAS (dial-up) connection:
1. Select File New Connection.
2. Choose Dial-Up Networking Connection and click Next. The New 

Conection Wizard will appear (see Figure 40).

Figure 40: New Connection Wizard 1

3. Enter the following information in the first window and click Next.
� Phone Number – The 10-digit phone number of your connection 

(including area code).

Note: You will need to enter the area code even if the dial-up number is a 
local number.

� Login – Your username for the dial-up network.
� Password – Your password for the dial-up network.
� Domain – Your domain name for the dial-up network (if applicable).
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4. Enter the name you would like to assign to the new dial-up 
connection and click Next to continue (see Figure 41).

Figure 41: New Connection Wizard 2

5. Click Finish to store the new dial-up connection (see Figure 42).

Figure 42: New Connection Wizard 3
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Editing a Dial-up Connection
Once you have configured new connections to your dial-up networks, 
you can edit the connection properties as necessary.

To edit a dial-up connection:
1. Select File Edit Connection.
2. The Edit Connection window will appear (see Figure 43). Choose the 

connection you wish to edit from the Select connection list.

Figure 43: Edit Connection

3. Edit the entries in the Phone Number, Login, Password and/or 
Domain fields and click OK to save the changes (or Cancel to discard).

Deleting a Dial-up Connection
To delete a dial-up connection:
1. Select File Edit Connection.
2. The Edit Connection window will appear (see Figure 43). Choose the 

connection you wish to delete from the Select connection list.
3. Click Delete. The Confirm Delete dialog box appears (see Figure 44).

Figure 44: Confirm Delete

4. Click Yes to permanently delete the connection.
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PCS Connection Card Configuration Window
To access the PCS Connection Card Configuration window (see 
Figure 45), select Configuration from the File drop-down menu.

Figure 45: PCS Connection Card Configuration window

The configuration window contains the following items:

Network Service List The values contained in this drop-down list box include:

Automatic - If this value is selected, the card will 

automatically search for any available network service 

(based on roaming agreements).

PCS - If this value is selected, the card will only attempt to 

connect with the Sprint Nationwide PCS Network.

Receive Next Call As 
List

Your card is configured to send or receive data 

transmissions only. 

Device Lock Option You have the option of locking or unlocking your card 

from this window. 

Set Lock Code You can change your current lock code by clicking the 

Set Lock Code button. 

Current System Time This field displays the current system time, as displayed on 

your computer’s desktop.
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PCS Connection Card Configuration Settings

Changing Your Roaming Settings
To change your roaming settings, select Configuration from the File 
menu (see Figure 46).

Figure 46: Configuration command

Current CDMA Time This field displays the time as indicated by the CDMA base 

station. If you have changed location, the time displayed 

in this field may be different from the time displayed in the 

Current System Time field.

Show Connection 
Properties

If you have previously disabled the Connection Properties 

window, selecting this check box will activate the window 

so it is visible when you attempt to connect to the network.

Enable Sound Alerts Selecting this check box will turn on sound alerts for your 

PCS Connection Card
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The PCS Connection Card Configuration window will open (see 
Figure 47). Select the desired value from the Network Service drop-
down list box, and click OK to save the new roaming settings. 

Figure 47: PCS Connection Card Configuration window

� The Automatic option directs the card to automatically search for 
any accessible network if you travel outside the PCS Service Area. 
If the Automatic option is selected, and you are using your card 
outside the PCS Service Area, the Roaming icon  will be visible on 
the Wireless Connection Manager’s main window.

� The PCS option directs the card not to roam outside the 
Sprint Nationwide PCS Network. 
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Changing Your Lock Code
To change your current lock code:
1. Select Configuration from the File menu.
2. From the PCS Connection Card Configuration window, click Set 

Lock Code. 
The Change Lock Code window will appear (see Figure 48).

Figure 48: Change Lock Code window

3. Enter the current lock code into the Old Code text field. 
4. Enter the new lock code into the New Code text field. 
5. Enter the new lock code in the Re-Enter Code text field. 
6. Click OK to accept the new lock code. 

The new lock code will be saved to the card, and the Change Lock Code 
window will close.
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PCS Connection Card Properties Window
To access the PCS Connection Card Properties window (see Figure 49), 
select Properties from the File menu.

Figure 49: PCS Connection Card Properties window

The information contained in this window can be helpful for 
PCS Customer Service Solutions in diagnosing any problems you may 
have with your card.

The following fields are displayed in the PCS Connection Card Properties 
window:

User Name This field displays your PCS User name.

Phone Number This field displays your card’s phone number.

ESN (HEX) This field displays your card’s Electronic Serial Number 

(ESN). The ESN is a unique number given to each card as 

a means of identification.

PRL Version This field displays your card’s Preferred Roaming List 

(PRL) version.

Firmware Version This field displays the firmware version your card uses.

Hardware ID This field displays your card’s hardware 

identification number.
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Detailed Status Report Window
To access the Detailed Status Report window, select Detailed Status 
Report from the Tools menu. The Detailed Status Report window 
contains two tabs: General and History.

Figure 50: Detailed Status Report window (General)

The General tab (see Figure 50) contains the following items:

Modem Type This field displays your PCS Connection Card model.

Manufacturer This field displays the name of the manufacturing 

company of the card.

Current Status Bar This status bar displays the card's current network 

connection status.

Total Bytes 
Transferred

This field displays the total number of bytes the card has 

sent and received during the network session.

Total Bytes Sent This field indicates the amount of data (bytes) the card 

has sent during the current network session.

Total Bytes Received This field indicates the amount of data (bytes) the card 

has received during the current network session.

Date Total Bytes 
Were Last Cleared

This field displays the date the byte totals were last cleared.
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The History tab (see Figure 51) displays the date, time, and current card 
and network session activities. This tab is useful when attempting to 
diagnose problems with either your card or your network connection.

Figure 51: Detailed Status Report window (History)

About Wireless Connection Manager Window
To access the About Wireless Connection Manager window (see Figure 52), 
select About Wireless Connection Manager from the Help menu.

Figure 52: About Wireless Connection Manager window

This window contains information about the Wireless Connection 
Manager application, including:
� The software version
� The date the software was released
� The copyright information
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Updating the Wireless Connection Manager Software
The Wireless Connection Manager will automatically check periodically 
for available updates to its software version. To manually check for 
software updates, select Start Wireless Connection Manager Update 
(see Figure 53).

Figure 53: Wireless Connection Manager Update

The Wireless Connection Manager Update Wizard will display 
(see Figure 54). Click Next. The update wizard will search for a software 
upgrade, and if one is available it will automatically update your 
Wireless Connection Manager Software.

Figure 54: Wireless Connection Manager Update Wizard
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Sect ion 3

PCS VisionSM

In This Section

� Web

� Messaging

� PCS Business ConnectionSM

CS VisionSM brings you clarity you can see and hear, with enhanced, 
always-on multimedia services like email, Internet browsing and 

PCS Business ConnectionSM that are easy to learn and use. This rich, colorful 
graphic experience will be visually comparable to your home or office 
computer. It's clearly a whole new way to look at wireless.

P
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Accessing the Web With Your 
PCS Connection Card

Launching the Web
To launch the Web:
� From the card’s main menu, highlight Web and select Launch.

Your User Name
When you buy a PCS Connection Card and sign up for service, you're 
automatically assigned a User name. Then, when you use PCS Vision, 
your User name is submitted to identify you to the Sprint Nationwide PCS 
Network. The User name is also useful as an address for email and 
instant messaging, as a way to personalize Internet services, and as an 
online virtual identity.

A User name is typically based on the customer's name and a number, 
followed by “@sprintpcs.com.” For example, the third John Smith to 
sign up for PCS Vision Services might have jsmith003@sprintpcs.com 
as his User name. If you want a particular User name, you can visit 
www.sprintpcs.com and get the name you want – as long as nobody 
else has it!

Note: If you already have a PCS Mail User name, that will automatically 
become your PCS Vision User name.

Your User name will be automatically programmed into your 
PCS Connection Card. You don't have to enter it.

Note: PCS Vision services are not available in certain Affiliate markets. 
See Service Area Guide for coverage details.

http://www.sprintpcs.com
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Messaging

Now you can send and receive email and instant messages on select 
PCS Connection Cards. These appear on your screen as Page/Text and 
include numeric messages as well as text PCS Messages.

Signing Up for Web Updates
With Web Updates, you can have news and information sent directly to 
your PCS Connection Card at the times you choose.

To select the information you want sent to your card:
1. From your computer, log on to the Internet.
2. Go to the site from which you want to receive information. A few of 

the sites you can visit are America Online®, Yahoo!®, MSN® and 
ebay®. (The location where you request updates within each site 
will vary.)

3. Where indicated on the site, input your 10-digit PCS Phone Number 
followed by “@messaging.sprintpcs.com.” For example: 
5551234567@messaging.sprintpcs.com.

Upon completing the registration process, you should begin receiving 
updates on your card as requested.
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Email

Using Email
With Email, you can set up an account at no additional charge and 
perform many of the typical email functions from your PCS Phone that 
you can from your personal computer.

You can manage your Email Account from your PCS Phone or personal 
computer at www.sprintpcs.com. You can also access other select email 
providers from the Web.

Accessing Email Messages
To access Email Messages:
1. From the Web home page, select the Messaging folder.
2. From the Messaging folder, select Email. If you’re a first-time user, 

prompts will help you set up your email account by establishing a 
User name and password.

3. To view your messages, select Inbox.
4. Select the message you wish to read.
5. Once you’ve read a message, use the quick actions at the end of each 

message (Erase, Reply, Reply All or Next Message) or select 
Menu for a full list of options. 

Composing Email Messages
To compose an Email Message:
1. From the home page, select the Messaging folder.
2. From the Messaging folder, select Email.
3. Select Compose.
4. Select Add Name to enter the address of the person to whom you’re 

sending a message and press OK.
5. Select Next to enter the subject of your email and your specific message.
6. Select Send when your message is ready to be delivered.

http://www.sprintpcs.com
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PCS Business ConnectionSM 
Personal Edition

PCS Business ConnectionSM Personal Edition is designed to offer secure 
wireless access to both Microsoft® Outlook® and Lotus Notes®.

PCS Business Connection Personal Edition delivers the 
following features:
� Business email access: Read, reply to, forward, delete and 

compose your company email.
� Company directory and contacts: Search, view, call, and email 

contacts from your company's directory. Do all this and add/edit 
your personal contacts.

� Work calendar: Accept and reject meetings, view daily summaries 
and details, navigate to various dates.

� Files/information on your PC: Browse folders, download and 
view documents from any device using a PC browser or Pocket 
Internet Explorer.

To use PCS Business Connection Personal Edition, visit 
businessconnection.sprintpcs.com and download the PCS Business 
Connection Personal Edition software to your work PC. This allows data 
to be securely retrieved in real-time by your wireless device when 
connected to the Sprint Nationwide PCS Network. There is a monthly 
charge for PCS Business Connection, and usage charges will also apply.

When your work PC isn't on, you can share connections with your 
co-workers so that you have always-on access to your email, calendar 
and contacts. Your data remains secure behind the company firewall and 
any changes you make on your wireless device are instantly updated on 
your company server without the need to synchronize.

Additional PCS Business Connection solutions are available to your 
company. For more details, visit businessconnection.sprintpcs.com.

http://businessconnection.sprintpcs.com
http://businessconnection.sprintpcs.com
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PCS Vision FAQs
How will I know when my card is ready for 
PCS Vision Service?
Your User name (for example, bsmith001@sprintpcs.com) will appear 
on the display screen.

How do I sign-in for the first time?
You are automatically signed in to PCS Vision Services when you turn on 
your phone. 

How do I know when my card is connected to 
PCS Vision Services?
Your card automatically connects when PCS Vision Service is used or an 
incoming message arrives. Your screen will also display the icon. 
(Connecting takes about 10-12 seconds.)

When is my data connection active?
Your connection is active when data is being transferred. Outgoing calls 
are allowed, but incoming calls go directly to voicemail. When active, an 
indicator flashes on your phone’s display screen.

When is my data connection dormant?
If no data is received for 10 seconds, the connection goes dormant. If no 
data is received for a long time, the connection will terminate.

Can I sign out of data services?
You can sign out without turning off your card, however you will not be 
able to access the Web or use other PCS Vision Services. You may sign in 
again at any time. 
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Sect ion 4

Troubleshooting Tips

In This Section

� PCS Connection Card Frequently Asked Questions

� Troubleshooting Error Messages

his section will provide you with help in diagnosing and 
solving problems that you may experience while using the 

PCS Connection Card. 

A list of frequently asked questions, as well as a detailed report of the various 
error messages, have been provided to assist you with determining the 
possible cause of the problem or error, and finding a viable solution.

If you require additional help, please visit our Web site at 
www.sprintpcs.com, or contact PCS Customer Service Solutions at 
1-888-211-4PCS (4727).

T

http://www.sprintpcs.com
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PCS Connection Card FAQs
How can I check the quality of my connection?
The signal strength status bar, located on the Wireless Connection 
Manager main window, indicates the quality of the card’s signal. If two or 
more bars are shaded green, the card’s signal strength is adequate. If less 
than two bars are shaded green, the signal strength is poor, and it will be 
difficult to establish and maintain a network connection.

How do I find out what version of the Wireless Connection 
Manager Software I'm using?
Open the main window, and select About Wireless Connection 
Manager from the Help menu. The software version, release date, and 
copyright information will be displayed in the About Wireless Connection 
Manager window.

How do I find out what version of firmware my 
PCS Connection Card is using?
Open the main window, and select Properties from the File menu. 
The card's Firmware Version and Hardware ID will be displayed in the 
File Properties window.

I have forgotten my User name and Password. What do I do?
Call PCS Customer Service Solutions at 1-888-211-4PCS (4727).

How can I tell if I have PCS Service?
Both the Wireless Connection Manager and your PCS Connection Card 
indicate whether you have service. The Wireless Connection Manager 
Software indicates the card’s connection status in the current status bar, 
located on the main window. The card’s LED (light emitting diode) 
indicator will flash red if there is no service available.

The Wireless Connection Manager won’t recognize my 
User name or Password. What do I do?
Call PCS Customer Service Solutions at 1-888-211-4PCS (4727).
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Troubleshooting Error Messages
One of the following error messages may be displayed if your card is 
unable to connect to the network.

The card is not 
responding properly.

You are directed to wait between 15-30 seconds and to then 

re-launch the Wireless Connection Manager Software. If 

the same message appears, you may have not inserted the 

card or installed the card drivers properly. Remove and 

reinsert the card into the PC card slot. Your computer 

should “beep” when it has detected the card. If the 

computer does not detect the card, re-install the software.

The card is not 
present.

This message could indicate that your card is not inserted 

into the PC card slot correctly, or that the card software was 

not properly installed. Remove and reinsert the card, and 

re-launch the Wireless Connection Manager application. 

If the card is not detected, reinstall the software.

No service. If this message is displayed, there is no service available at 

this time. The network may be busy, or undergoing 

maintenance. Try connecting to the network at a later 

time, or moving to another location.

The connection failed 
because the card was 
not found.

If this message is displayed, verify that the card is properly 

inserted, or that another device or application is not using 

the card’s COM Port (such as HotSync). 

There is no answer. If this message is displayed, the card’s signal strength 

could be inadequate, or the network could be busy. 

Check the Signal Strength status bar, located on the main 

window (two or more bars shaded green indicate a fair 

signal). If the signal strength is poor, try moving to a 

different location.

Card is already in use. If this message is displayed, the card’s COM Port is being 

used by another device or application. Shut down all 

conflicting applications.
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Access denied 
because User name 
and/or password is 
invalid on the domain.

Contact PCS Customer Service Solutions at 

1-888-211-4PCS (4727).

The card has been 
removed.

This message indicates the card was removed while the 

Wireless Connection Manager was running.
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Sect ion 5

Product Specifications

In This Section

� Technical Specifications

� Environmental Specifications

his section outlines the technical and environmental specifications 
for your new PCS Connection Card.T
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Technical Specifications
This product was manufactured under the US patent 5129098.

Merlin C201

Environmental Specifications

Approvals: IS95A/CDMA2000 1X

FCC Parts 15 and 24

Voltage: +5.0 Vdc from PCMCIA Slot

Current: 850 mA

Transmitter Power: 200 mW (Class II) full duplex

Transmit: 1850 to 1910 MHz

Receive: 1930 to 1990 MHz

Frequency Error: +/- 150 Hz

Operating Temperature:  -20 to +60 degrees C

Storage Temperature: -30 to +85 degrees C

Humidity: 90 to 100% (95%)

Vibration: 15g within the frequency range of 10 to 2000 Hz

Drop: 75 cm onto a vinyl-tile surface
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Sect ion 6

Safety and Regulations

In This Section

� Important Notice

� Safety and Hazards

� Regulatory Notices

his section outlines important safety guidelines and regulations 
regarding the use of your PCS Connection Card and 

Wireless Connection Manager Software.
T
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Important Notice
Because of the nature of wireless communications, transmission 
and reception of data can never be guaranteed. Data may be delayed, 
corrupted (i.e., have errors) or be totally lost. Although 
significant delays or losses of data are rare when wireless devices 
such as the PCS Connection Card are used in a normal manner with a 
well-constructed network, they should not be used in situations 
where failure to transmit or receive data could result in harm of 
any kind to the user or another party, including but not limited to, 
personal injury, death, or loss of property. Novatel Wireless Inc. and 
Sprint Communications Company, L.P., accept no responsibility for 
damages of any kind resulting from delays or errors in data transmitted 
or received using the PCS Connection Card, or for failure of the 
PCS Connection Card to transmit or receive such data.

Safety and Hazards
Do not operate the PCS Connection Card in areas where blasting is in 
progress, where explosive atmospheres may be present, near medical 
equipment, near life support equipment, or any equipment which may 
be susceptible to any form of radio interference. In such areas, the 
PCS Connection Card MUST BE TURNED OFF. It can transmit signals 
that could interfere with this equipment.

Do not operate the PCS Connection Card in any aircraft, whether the 
aircraft is on the ground or in flight. In aircraft, the PCS Connection 
Card MUST BE TURNED OFF. When operating, it can transmit signals 
that could interfere with various onboard systems.

The driver or operator of any vehicles should not operate the 
PCS Connection Card while in control of a vehicle. Doing so will detract 
from the driver or operator’s control and operation of that vehicle. In 
some jurisdictions, operating such communications devices while in 
control of a vehicle is an offense.
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Regulatory Notices
This device complies with Part 15 of the FCC Rules. Operation of this 
device is subject to the following two conditions: (1) this device may not 
cause harmful interference, and (2) this device must accept any 
interference received, including interference that may cause undesirable 
operations. FCC guidelines stipulate that the antenna should be more 
than 1.5 cm (5/8”) from all persons.

FCC ID: PKRNVWC201

Where appropriate, the use of the PCS Connection Card is subject to the 
following conditions:

Caution – Unauthorized modifications or changes not expressly 
approved by Novatel Wireless, Inc. could void compliance with regulatory 
rules, and thereby your authority to use this equipment.

Warning (EMI) – United States FCC Information – This equipment 
has been tested and found to comply with the limits pursuant to Part 15 
of the FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference in an appropriate installation. 
This equipment generates, uses, and can radiate radio frequency energy 
and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio communication. However, there is 
no guarantee that interference will not occur in a particular installation.

If this equipment does cause harmful interference to radio or television 
reception, which can be determined by turning the equipment off and 
on, the user is encouraged to try to correct the interference by one or 
more of the following measures:
� Reorient or relocate the receiving antenna,
� Increase the separation between the equipment and receiver,
� Connect the equipment into an outlet on a circuit different from that 

to which the receiver is connected,
� Consult the dealer or an experienced radio/TV technician for help.
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Warning (EMI) – Canada – This digital apparatus does not exceed the 
Class B limits for radio noise emissions from digital apparatus as set out 
in the interference causing equipment standard entitled “Digital 
Apparatus”, ICES-003 of the Department of Communications.

Cet appareil numerique respecte les limites de bruits radioelectriques 
applicables aux appareils numeriques de Class B prescrites dans la 
norme sur le materiel brouilleur: “Appareils Numberiques”, NMB-003 
deictee par le ministre de Communications.

If you have purchased this product under a United States Government 
contract, it shall be subject to restrictions as set forth in subparagraph 
(c)(1)(ii) of defense Federal Acquisitions Regulations (DFARs) Section 
252.227-7013. For Department of Defense contracts, as set forth in 
Federal Acquisitions Regulations (FARs) Section 52.227-19 for civilian 
agency contracts or any successor regulations. If further government 
regulations apply, it is your responsibility to ensure compliance with 
such regulations.
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Sect ion 7

Terms and Conditions & 
Warranty Information

In This Section

� Terms and Conditions of Services

� Manufacturer’s Warranty

his section contains the Terms and Conditions of service and the 
manufacturer’s warranty for your PCS Connection Card.T
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Terms and Conditions of Services
(Effective as of August 1, 2002 until replaced) 

Thanks for choosing Sprint. These terms and conditions are part of your 
agreement with Sprint for PCS Services. 

For the most current version of the terms and conditions, please visit our 
Web site at www.sprintpcs.com or call PCS Customer Service SolutionsSM 
at 1-888-211-4PCS, because the terms and conditions included with your 
PCS Phone may not the most current version. If you activated 
PCS Services before the effective date of these terms and conditions, 
these terms and conditions replace and supersede any previous terms 
and conditions.

If you have questions about your PCS Services, call PCS Customer Service 
SolutionsSM at 1-888-211-4PCS (4727) or visit our Web site at 
www.sprintpcs.com. 

Agreement. Your agreement (“Agreement”) with Sprint Spectrum L.P. 
and any of its Affiliates doing business as Sprint providing PCS Services 
(“Services”) to you is made up of these Terms and Conditions of Service 
(“Terms”) and the Service Plan that we agree to provide you. Your 
“Service Plan” is described in our marketing materials, and includes the 
rates and features we set for that Service Plan. We use the words “we,” 
“us,” “our” or “Sprint” to refer to Sprint Spectrum L.P. and its Affiliates 
doing business as Sprint in these Terms. When you activate PCS Services 
or attempt to use our PCS Services (including, without limitation, 
attempting to place a call on the Sprint Nationwide PCS Network, or off 
the Sprint Nationwide PCS Network when roaming, including “911” or 
similar calls), you accept the Agreement.

Provision of Service. Your purchase of PCS Phones or other equipment 
does not mean that we must provide Services to you. We may decide not 
to provide Services to you for any lawful reason. We may request that you 
provide us with any information we reasonably require to determine 
whether you qualify for Services. Services in some areas are managed 
and provided under contract with Sprint by independent Affiliates with 
access to the Sprint Nationwide PCS Network. Some Services may not be 
available or may operate differently in certain Affiliate markets.

http://www.sprintpcs.com
http://www.sprintpcs.com
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Credit Verification. You must have and keep satisfactory credit to receive 
and continue to receive Services. We will verify your credit before agreeing 
to provide Services to you and we may verify your credit at any time while 
we provide Services to you. Credit verification may include a review of 
credit reports that we receive from commercially available credit bureaus. 
We may require a guarantee of payment by an individual or entity 
approved by us. If at any time we determine, in our sole discretion, that 
payment for Services may not be made when due, we may suspend 
Services to your phone and require that you provide payment on account 
or a guarantee of payment before we resume Services to your phone.

Changes to Agreement. We may change this Agreement at any time 
(but see PCS Service Plan). Any changes to the Terms are effective when 
we publish the revised Terms. If you use our Services or make any 
payment to us on or after the effective date of the changes, you accept the 
changes. If you do not accept the changes, you may terminate Services 
(but see Termination and Changing PCS Service Plans). For purposes of 
the Agreement, “use” includes keeping the right to access the Sprint 
Nationwide PCS Network by not terminating Services. You may not 
modify the Agreement except for your PCS Service Plan (see Termination 
and Changing Service Plans).

Service Plan. You may be eligible for a fixed length PCS Service Plan 
(“Term Service Plan”) or for a month-to-month Service Plan (“Non-
Term Service Plan”). We determine the Service Plan for which you 
qualify. We may offer non-identical Service Plans to different individuals 
or entities. Services and coverage under some Service Plans may be more 
limited than available under other Service Plans. Your Service Plan sets 
out the charges for Services and is your Service Plan until that Service 
Plan is changed, you switch to a different Service Plan, or your Services 
terminate. Your Service Plan may require that you make a deposit, 
prepayment, or a series of deposits or prepayments, or be subject to an 
account spending limit, before Services are activated or maintained.

Changing Service Plans. If you are on a Non-Term Service Plan, you 
may change to a different Service Plan for which you qualify. Any change 
is effective at the start of your next full invoicing cycle unless otherwise 
specified by us at the time that you place your change order. If you 
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change or add a different Service Plan or service feature and the change 
is effective prior to the start of your next full invoicing cycle, you will be 
invoiced a prorated amount. We may require a service charge for 
implementing any change directed by you as well as the Service Plan or 
optional service features you select. If you are on a Term Service Plan, 
your ability to change to another Service Plan may be limited and we 
may require you to pay a termination fee as set out in your Service Plan. 

Use of Services and Equipment; Availability. You must be at least 
18 years old to subscribe to our Services. We may require you to provide 
proof of your age and identity. If you are under 18 years old you may be 
eligible for certain Services that have Account Spending Limits if a person 
18 years or older is also named as a subscriber on the Account. Services 
and equipment may not be used for any unlawful, fraudulent or abusive 
purpose. By requesting Services, you agree that you will not use Services 
and equipment in any unlawful, fraudulent or abusive manner. You may 
not resell or lease Services or equipment to anyone. Services are available 
within the operating range of the Sprint Nationwide PCS Network. 
Coverage and quality of Services may be affected by conditions within or 
beyond our control, including atmospheric, geographic, or topographic 
conditions. We do not guarantee that there will be no interruptions or 
delays in Services. Your PCS Phone will not accept the services of any 
wireless provider other than Sprint (but see Roaming).

Number. We assign a phone number (“Number”) to the phone or other 
equipment used by you on the Sprint Nationwide PCS Network. We may 
change the Number without compensation by giving you prior notice. 
You do not own the Number. You may not modify the Number we 
program into any phone or other equipment, transfer or duplicate the 
Number to any phone or other equipment other than that authorized by 
us, or transfer the Number to any other individual or entity.

Phone Activation Fee. You may be required to pay a non-refundable 
phone activation fee when you activate a new Number, have us switch a 
Number to a different phone, have your current Number changed, we 
activate a different phone on your existing account or your Service Plan 
says so. Details on any applicable phone activation fee are set out in your 
Service Plan or can be obtained by calling PCS Customer Service Solutions. 
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Charges. For most forms of wireless Service, your usage will be charged 
from the time you first initiate contact between your phone or other 
wireless device and the network until the network connection is broken, 
whether or not you are successful in connecting with the service with 
which you seek to connect, even if the connection is later broken or 
dropped. An exception is that you are not charged for voice calls that are 
not completed. You are charged for completed calls to your Number from 
the time shortly before the phone starts ringing until the call is terminated 
by either party. You will be charged peak rates for the entire duration of 
calls initiated during the peak time periods applicable to your Service. You 
will be charged off-peak rates for the entire duration of calls initiated 
during the off-peak time periods applicable to your Service. In addition to 
these usage charges, you may be charged for recurring monthly service 
charges, applicable local and long-distance toll charges, other usage 
charges, connection fees, roaming charges, directory assistance, call 
completion charges, account review and management charges optional 
features you select at an extra cost, and taxes and other regulatory-related 
charges. Charges for most Services are incurred in one-minute 
increments, with partial minutes of use rounded up to the next highest 
minute. You must pay, by each invoice due date, all charges for Services 
provided to the Number for each phone or other equipment that our 
records show you activated, no matter who actually uses or has possession 
of the phone or other equipment at the time Services are provided.

PCS Vision (Third Generation) Wireless Charges. For PCS Vision 
wireless services, you will be charged, on a per kilobyte basis, for Web 
access, whether sent or received by your PCS Phone or other wireless 
device, rather than for airtime used, even for certain PCS Vision voice 
services. As long as your PCS Phone or other wireless device is connected 
to the enhanced (Third Generation) Sprint Nationwide PCS Network, you 
will be incurring data usage charges. You cannot receive incoming calls 
while using third generation services. Data packet usage will be 
measured in kilobytes and will be rounded up to the next whole kilobyte. 
Kilobyte usage will be rounded up to the next full cent. Rounding up will 
occur at the end of each separate session or each clock hour (at the top of 
each hour), if the session spans more than 1 clock hour. When traveling 
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on the Vision network, a session may be ended and new session initiated, 
although no interruption to the actual data session will occur. Each 
individual session will be rounded up. The number of data packets used 
and charged to you will vary widely, depending upon the specific 
PCS Vision wireless application or other service you use and the amount 
of data used in the specific application or service. You will be charged for 
data exchanges initiated by other Internet users as well as those you 
initiate. Estimates of data usage, for example, the size of downloadable 
files, will vary from what you actually use. You will be charged for 
additional data used in transporting and routing on the network. If you 
use a Premium Service (including services provided by third parties but 
for which you are billed on your PCS Invoice), you will be charged for 
data used in transport and routing in addition to the charge for the 
Premium Service. You will be charged for partial and interrupted data 
downloads or other use, including re-sent data, and for unsuccessful 
attempts to reach Web sites and use other applications and services, 
including those resulting from dropped network connections. Your 
invoice will not separately identify the number of kilobytes attributable to 
your use of specific sites, sessions or services used. Specific additional 
information about PCS Vision wireless services, including pricing, 
included kilobytes and combining with other PCS Service Plans, is 
available in our standard sales collateral for PCS Vision wireless 
Service Plans or at www.sprintpcs.com.

PCS Voice CommandSM. PCS Voice CommandSM is an optional service that 
allows you to place calls by using speech recognition technology. Calls to 
911 or similar emergency numbers cannot be placed through the 
PCS Voice Command feature. Airtime and applicable long distance 
charges for a call completed from your Number using the 
PCS Voice Command feature begin when you press or activate the 
TALK or similar key(s) and end when your call is terminated by hitting the 
END key or by returning to the PCS Voice Command platform. 
If you initiate and complete another call without leaving the 
PCS Voice Command platform, a separate charge for that call will begin 
from the time the previous call was terminated. Airtime and applicable 
long distance charges will be applied to the entire length of a completed 

http://www.sprintpcs.com
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call initiated from PCS Voice Command. Using Directory Assistance to input 
names into your PCS Voice Command address book will incur additional 
charges. Details on charges for the PCS Voice Command feature can be 
found in the marketing materials for this feature, by visiting 
www.sprintpcs.com or by calling PCS Customer Service Solutions. 

Invoicing. Invoicing cycles are approximately 30 days in length. 
Invoicing cycles and dates may change from time to time. Except as 
otherwise provided in your Service Plan, monthly recurring charges 
(MRCs) are invoiced one invoicing cycle in advance. Charges for Services 
are usually invoiced as soon as possible after the charges accrue. We may, 
however, invoice you for usage and charges occurring before the 
invoicing cycle being invoiced, if they were not previously invoiced. If you 
are invoiced for usage incurred during a prior invoicing cycle, those 
minutes will be applied to your Service Plan minutes for the current 
invoicing cycle. However, if you change your PCS Service Plan between 
the time the usage was incurred and the beginning of the current 
invoicing cycle, those minutes from the prior invoicing cycle will be 
charged at the rate per minute for usage over included minutes provided 
in the Service Plan in effect at the time the usage was incurred. 

Additional Terms for Premium Services. Access to and downloading of 
premium content is not included with PCS Vision services. Certain 
PCS Vision services (e.g., games, ringers and screen savers) contain 
mostly premium services content. Your invoice will not separately 
identify the number of kilobytes attributable to your use of specific sites, 
sessions or services used. You will be charged for Premium Services at the 
rates and charges specified at the time of access or download, in addition 
to data usage charges you will incur while connected to the Sprint 
Nationwide PCS Network. You will be charged for partial and interrupted 
data downloads or other use, including data that is resent, and for 
unsuccessful attempts to reach Web sites and use other applications and 
services, including those resulting from dropped network connections. 
We provide no warranties and makes no representations or claims with 
regard to the third party Premium Services. In certain instances, subject 
to the terms of the content purchased, we may delete premium and non-
premium items downloaded to available storage areas (e.g., your vault) 

http://www.sprintpcs.com
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including any pictures, games and other content. We may impose a 
dollar or other limit on use of Premium Services including a limit the 
amount of Premium Service charges that you will be allowed to incur in 
a specific timeframe (month, week, day, or other time period). We may 
suspend your use of Premium Services without prior consent or notice if 
we have reason to suspect fraudulent or unauthorized use of your 
Premium Services account, but we make no assurances that we will 
suspend your account. 

Payment. If you have authorized payment for Services or equipment by 
credit card or by debiting a bank account, no additional notice or 
consent is required before we invoice the credit card or debit the bank 
account for all amounts due to us or billed by us on behalf of a third 
party. You must promptly notify us of any change in your invoicing 
address or of the credit card or bank account used for payment. We 
reserve the right to require payment by money order, cashier's check or 
other secured form of payment. If we take action to receive payment 
beyond invoicing you for charges for Services or equipment, you must 
pay our costs and expenses of collection, including attorneys' fees and 
expenses, the fees of any collection agency and court costs. If we act as an 
invoicing agent for a third-party service provider, payments received are 
first applied to amounts due and owing to us and any remaining 
amounts are applied to sums due and owing to the third-party service 
provider. We may charge an additional fee for any check or other 
negotiable instrument endorsed by you and returned unpaid by a 
financial institution for any reason. You may be charged fees for certain 
methods of payment.

Late Payment Charges. Payment is past due if we do not receive it by 
the due date shown on your invoice. Any payment for Services and 
equipment not made when due accrues late charges until paid at the rate 
of 5% per month or at the highest rate allowed by law. Acceptance of late 
or partial payments (even if marked “paid in full”) does not waive our 
right to collect all amounts that you owe us. If your Service has been 
suspended due to non-payment, you may be charged a reactivation fee.

Disputed Charges. You must raise any dispute that you have about any 
charges invoiced to you within 15 days of the date of the invoice or you 
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have accepted the invoice. You may notify us of any dispute by notifying 
PCS Customer Service Solutions. Calls to our sales or general business 
offices are not notice of a dispute. If disputed invoice procedures are 
described on the invoice, you must follow them.

Termination. Non-Term Service Plan. If you are on a Non-Term 
Service Plan you may terminate Services at any time by giving us notice. 
Subject to the terms of this Agreement, we may terminate Services at any 
time, with or without notice. If your Service has been suspended due to 
non-payment, you may be charged a reactivation fee. We may deactivate 
any Number before you receive notice of termination without liability to 
you. Termination by either of us may be with or without cause.

Termination. Term Service Plan. If you are on a Term Service Plan (1) 
your ability to terminate Services before the end of the term is limited, 
(2) your ability to change to another Service Plan before the end of the 
term may be limited, and may result in a termination or activation fee, 
(3) you may be required to pay a termination fee, (4) we may not 
terminate Services without cause before the end of the term and (5) if we 
terminate Services for cause before the end of the term, you may be 
required to pay a termination fee. No termination fee is charged if you 
terminate a Term Service Plan within 14 days of activation of your 
PCS Phone. During the term we must give each other notice to terminate 
Services. At and after the expiration of the term, you may terminate 
Services at any time by giving us notice and we may subject, to this 
Agreement, terminate Services at any time, with or without notice. 

Termination. General. Regardless of whether you have a Non-Term or a 
Term Service Plan, we may terminate or suspend Services to you without 
liability (1) if you breach any provision of this Agreement (including if 
you fail to pay any charges for Services), or (2) if you fail to pay any 
charges due us for equipment or otherwise. If you promptly cure the 
breach, we may, but are not obligated to, reactivate Services to you. You 
must pay all charges for (a) Services provided before termination of a 
Number, (b) equipment, regardless of who terminates Services and (c) a 
reactivation fee, if we agree to reactivate Services to you. If Services are 
terminated before the end of your current invoicing cycle (i) the monthly 
recurring charge is not prorated to the date of termination, and (ii) you 
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will not receive a credit or refund for any unused minutes in your 
Service Plan. 

Account Spending Limit. If we agree to provide Services to you on an 
Account Spending Limit basis, we will tell you your Account Spending 
Limit before we start Services to your Number, or as reasonably 
practicable after the limit is imposed. If we require a deposit for you to 
establish or keep Services on an Account Spending Limit basis, we will 
hold the deposit as partial guarantee of payment for Services (see 
Deposits). Charges for Services accrue against your Account Spending 
Limit as they are incurred. We may charge an initial ASL start up fee. We 
may charge a monthly ASL service fee, in addition to your recurring 
monthly service charge. We may suspend Services to your Number 
without prior notice to you when your account balance reaches your 
Account Spending Limit. Services are restored when you have paid any 
past due balance and pay a specified minimum amount to reduce your 
account balance below your Account Spending Limit. We may change 
this minimum amount at any time upon notice to you. You may pay any 
past due balance and the minimum amount by any method authorized 
by Sprint. Contact PCS Customer Service Solutions for information about 
authorized methods of making these payments. We may charge you a fee 
for calls that involve our live customer care services. If we provide 
Services to you on an Account Spending Limit basis, Services and 
coverage may be limited in certain ways. You must pay all charges for 
Services even if they exceed the amount of your Account Spending Limit.

PCS Clear Pay Program. If we agree to provide Services to you as a 
PCS Clear Pay Program customer, we may suspend Services to your 
Number without prior notice to you immediately when your bill becomes 
past due. Even if your bill is not past due, we may suspend services if your 
unpaid usage exceeds $125 or another amount to be determined by your 
past credit or usage history. If we require a deposit for you to establish or 
keep Services as a PCS Clear Pay Program customer, we will hold the 
deposit as partial guarantee of payment for Services (see Deposits, 
below). Contact PCS Customer Service Solutions for information about 
authorized methods of making these payments. We may charge you a fee 
for calls that involve our live customer care services. If we provide 
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Services to you on as a PCS Clear Pay Program basis, Services and 
coverage may be limited in certain ways. You must pay all charges for 
Services whether or not your Services are suspended or terminated.

Deposits. If we require a deposit for you to establish or keep Services, we 
will hold the deposit as partial guarantee of payment for Services. We 
may change the deposit amount at any time to reflect revised estimated 
monthly charges based upon your usage. A deposit may not be used to 
pay any invoice (unless it is used to pay a final invoice) or delay 
payment. The deposit amount, the length of time we hold the deposit and 
changes to the deposit amount are determined based on your credit and 
payment history. The rate of interest, if any, on the deposit is subject to 
change. We may mix deposits with our other funds. If Services are 
terminated for any reason, we may, without notice to you, apply your 
deposit toward payment of outstanding charges and return any excess to 
you at your last known address within 75 days after termination of 
Services. If the U.S. Postal Service cannot deliver the money to you and 
returns it to us, we will hold it for you for one year from the date of return 
and, during that period, we may charge a servicing fee against the 
deposit balance. Any money held during this one-year period will not 
accrue interest for your benefit. You forfeit any portion of the money left 
after the one-year period.

PCS Wireless Web and Voice Portal Services. PCS Wireless Web 
Services are part of the Services that can be obtained through Sprint. 
PCS Wireless Web Services may not be immediately available in some 
PCS Affiliate markets. Use of PCS Wireless Web Services requires a wireless 
Internet-ready PCS Phone or certain other equipment (or both) and is 
subject to any memory, storage or other limitation in the phone or other 
equipment. The Caller ID blocking feature is not available when using 
PCS Wireless Web Services. For data calls (including PCS Wireless Web 
and Voice Portal calls) that are attempted, but not completed, you are 
charged for the time during which the network attempts to connect the 
call. You are charged for time spent connected to the PCS Wireless Web or 
Voice Portal, including time spent browsing on the Internet or Voice 
Portal and reviewing or scrolling through Internet information on-line 
while still connected to the Sprint Nationwide PCS Network. Not all 
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Internet sites can be accessed and you may receive an error message if 
you attempt to access a site that cannot be accessed through PCS Wireless 
Web Services. You are also charged for PCS Wireless Web connections to 
review your PCS account information. PCS Wireless Web Services and 
Voice Portal calls may not be available when you are roaming off the 
Sprint Nationwide PCS Network. PCS Wireless Web Services are not 
available to you if you are on a PCS Prepaid Service Plan. If you receive 
Services on an Account Spending Limit basis, you may be limited in the 
PCS Wireless Web and Voice Portal Services available to you. 
Call PCS Customer Service Solutions or visit our Web site at 
www.sprintpcs.com for availability and equipment compatibility 
information. Specific additional information about PCS Wireless Web 
Services and Voice Portal Services, including pricing, included minutes 
and combining with other Service Plans, is available in our standard 
sales collateral for PCS Wireless Web Services and Voice Portal Services or 
at www.sprintpcs.com. Sprint is not a publisher of third party content 
that can be accessed through PCS Wireless Web Services or Voice Portal 
Services. Sprint is not responsible for any opinions, advice, statements, 
services or other information provided by third parties and accessible 
through PCS Wireless Web Services or Voice Portal Services. Neither 
Sprint nor its vendors or licensors guarantees the accuracy, completeness 
or usefulness of information that is obtained through the PCS Wireless 
Web Services or Voice Portal Services. You are responsible for evaluating 
such content.

Other Terms Applicable to PCS Vision Usage. Use of PCS Vision 
Services requires the purchase of separate third generation wireless 
compatible phone or other device and is subject to any software, memory, 
storage or other limitation in the phone or other equipment. Not all 
applications and services work, or work the same, on all third generation 
wireless phones and devices. Check the materials accompanying your 
phone or device to determine which applications and services it will 
support. PCS Vision Services are not available when roaming off the 
Sprint Nationwide PCS Network. PCS Vision Services may not be currently 
available in some Affiliate areas.

http://www.sprintpcs.com
http://www.sprintpcs.com
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Sprint is not responsible for any opinions, advice, statements, services 
applications or other information provided by third parties and accessible 
through PCS Vision Services. Neither Sprint nor its vendors or licensors 
guarantees the accuracy, completeness or usefulness of information that 
is obtained through the PCS Vision Services. You are responsible for 
evaluating such content. Use of certain PCS Vision Services, including 
some messaging services, may result in the disclosure to others of your 
email address and other information about you in connection with your 
Internet usage. Your accessing of, or use of, third party sites or services 
accessible PCS Vision Services may require the disclosure of information 
about you, subject to the policies of those sites and services.

You consent to receiving advertising, warnings, alerts and other 
messages, including broadcast messages.

Your access to PCS Vision Services is controlled by a password.

Taxes and Other Regulatory-Related Charges. We invoice you for 
taxes, fees and other charges levied by federal, state or local authorities, 
or foreign government on Services. We also assess charges associated with 
regulatory mandates and obligations, such as Universal Service and 
Enhanced 911 service. If you claim any tax exemption, you must provide 
us with a valid tax-exempt document. Any tax exemption applies only 
from the date we receive a valid tax-exempt document. 

Roaming. Calls made outside of your Home Service Area and off of the 
Sprint Nationwide PCS Network are “roaming” calls. Your PCS Phone is 
specifically designed and engineered to work only on the Sprint 
Nationwide PCS Network. It works on another CDMA PCS provider's 
system only when a roaming agreement is in place between Sprint and 
the other providers. If your PCS Phone is a dual-mode phone, it works on 
both a CDMA PCS provider's system (in addition to the Sprint Nationwide 
PCS Network) and a wireless analog telecommunications provider's 
system only when roaming agreements are in place between Sprint and 
the other providers. If we do not have a roaming agreement in place, you 
may be able to place roaming calls “manually” by using a valid credit 
card. If there is a gap or other interruption of coverage within a 
PCS coverage area that prevents connection with the Sprint Nationwide 
PCS Network and your dual-band phone is set to roam automatically 
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when outside PCS coverage, you may incur roaming fees within a 
PCS coverage area. Certain features are not available when roaming. 
Roaming rates may be different from and higher than the rates you pay 
for calls within your Sprint PCS Local Service Area and on the 
Sprint Nationwide PCS Network. When roaming, you are subject to the 
limitation of liability provisions and other applicable rules imposed by 
the roaming service provider.

Interruption of Service. We may give credit for a continuous 
interruption of Services for more than 24 hours on a case-by-case basis. 
Interruptions caused by your negligent or willful actions, or by failure of 
equipment or service not provided by us, or by causes beyond our 
reasonable control, do not qualify for credit. We may provide you with an 
airtime credit of one minute for a call that is disconnected because of 
transmission limitations caused by atmospheric, geographic or 
topographic conditions and that you redial within one minute of 
disconnection. You must notify us within 24 hours of the disconnection 
to request credit.

Phones and Other Equipment. Phones and other equipment may be 
purchased and returned as provided in the purchase documents. We are 
not the manufacturer of the phones or other equipment. The only 
warranties on the phones or other equipment are any limited warranties 
extended by the manufacturers. We have no liability in connection 
with the phones and other equipment or for the manufacturers' acts 
or omissions.

Lost or Stolen Equipment. If your phone or other equipment is lost or 
stolen, you must notify us by calling PCS Customer Service Solutions. 
You are responsible for all charges for Services provided to the Number 
for the lost or stolen equipment before you notify us of the loss or theft. 
We will deactivate Services to the Number upon notification to us of any 
loss or theft. You may be required to provide evidence of the loss or theft 
(for example, a police report or sworn statement). If the equipment is 
later found, we may require that you exchange it for another phone or 
other equipment before we reactivate Services (if we do reactivate 
Services), as well as require you to pay a reactivation fee. We will 
deactivate Services to any Number without prior notice to you if we 
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suspect any unlawful or fraudulent use of the Number. You agree to 
cooperate reasonably with us in investigating suspected unlawful or 
fraudulent use.

Caller ID. If you do not want people you call to receive the Number 
assigned to your phone, you must call PCS Customer Service Solutions 
for information about automatic Caller ID blocking. The Number 
assigned to your phone can be blocked on a per-call basis by dialing 
*67 + Destination Number + TALK (or similar key), but Caller ID 
delivery resumes on the next call you make. Caller ID display on 
incoming calls to your Number depends on receiving the information 
from the calling party.

TTY Access. A TTY (also known as TDD or Text Telephone) is a 
telecommunications device that allows people who are deaf or hard of 
hearing, or who have speech or language disabilities, to communicate by 
telephone. TTY doesn’t work with all PCS Phones. If you have a PCS TTY-
capable phone, it may not function effectively, or at all, when attempting 
911 calls due to the equipment or software of the answering agency. 
Therefore, a TTY device should not be relied on for 911 calls. 

Pay-Per-Call Service. We will not complete calls from your Number to 
900, 976 and similar numbers for pay-per-call services.

International Calling. You may be limited in the international 
destinations that you can call with Services. You should contact 
PCS Customer Service Solutions for information about international 
destinations that you cannot call.

Limitation of Liability. Except as otherwise provided in this section, our 
sole liability to you for any loss or damage arising out of providing or 
failing to provide Services (including mistakes, omissions, interruptions, 
delays, errors, or defects) does not exceed (1) in cases related to a specific 
piece of equipment, the prorated MRC for Services to the piece of 
equipment during the affected period, or (2) in cases not related to a 
specific piece of equipment, the prorated MRCs for Services to you during 
the affected period. Neither we nor our vendors, suppliers or licensors are 
liable for any damage arising out of or in connection with:
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a) any act or omission of any telecommunications service or other 
service provider other than us;

b) any directory listing;

c) any dropped calls or inability to place or receive calls;

d) any interruption of Services, including interruptions caused by 
equipment or facilities failure or shortages, transmission limitations or 
system capacity limitations;

e) traffic or other accidents, or any health-related claims allegedly 
arising from the use of Services, phones, equipment or accessories used 
in connection with the Services;

f) the use of PCS Wireless Web Services and PCS Vision applications and 
services, including the accuracy or reliability of any information 
obtained from the Internet using PCS Wireless Web Services or from 
Voice Portal Services, PCS Vision Services or Internet services, content or 
applications not supported by Sprint Nationwide PCS Network;

g) any late or failed message delivery;

h) any interruption or failure of 911 or E911 emergency services or 
identification of the Number, address or name associated with any person 
accessing or attempting to access emergency services from your phone;

i) the installation or repair of any products or equipment by parties who 
are not our authorized employees or agents;

j) events due to factors beyond our control, including acts of God 
(including, without limitation, weather-related phenomena, fire or 
earthquake), war, riot, strike, or orders of governmental authority;

k) any act or omission of any third party or independent contractor that 
offers products or services in conjunction with or through the Services; or

l) your negligent or intentional act or omission.

NO CONSEQUENTIAL OR OTHER DAMAGES. UNDER NO 
CIRCUMSTANCES ARE WE LIABLE FOR ANY INCIDENTAL, 
CONSEQUENTIAL, PUNITIVE OR SPECIAL DAMAGES OF ANY NATURE 
WHATSOEVER ARISING OUT OF OR IN CONNECTION WITH 
PROVIDING OR FAILING TO PROVIDE SERVICES, PHONES OR OTHER 
EQUIPMENT USED IN CONNECTION WITH THE SERVICES, 
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INCLUDING, WITHOUT LIMITATION, LOST PROFITS, LOSS OF 
BUSINESS, OR COST OF REPLACEMENT PRODUCTS AND SERVICES. 
THIS SECTION SURVIVES TERMINATION OF THIS AGREEMENT.

Indemnification. You indemnify and defend us, our partners, directors, 
officers, employees and agents from and against any claim, action, 
damage, liability and expense arising out of or in connection with: (1) 
your acts or omissions that occur in connection with your use of the 
Services or equipment used in connection with the Services, and (2) any 
communications you make or receive using the Services. This 
indemnification extends to and includes any attorney's fees and costs 
incurred by us arising from any actions or claims to which this 
indemnification applies, or from the contesting of the applicability of 
this provision. This section survives termination of this Agreement.

MANDATORY ARBITRATION OF DISPUTES. ANY CLAIM, 
CONTROVERSY OR DISPUTE OF ANY KIND BETWEEN THE CUSTOMER 
AND THE COMPANY AND/OR ANY OF ITS' EMPLOYEES, AGENTS, 
AFFILIATES OR OTHER REPRESENTATIVES, WHETHER SOUNDING IN 
CONTRACT, STATUTE, OR TORT, INCLUDING FRAUD, 
MISREPRESENTATION, FRAUDULENT INDUCEMENT, OR ANY OTHER 
LEGAL OR EQUITABLE THEORY AND REGARDLESS OF THE DATE OF 
ACCRUAL OF SUCH CLAIM, CONTROVERSY OR DISPUTE SHALL BE 
RESOLVED BY FINAL AND BINDING ARBITRATION AS PRESCRIBED IN 
THIS SECTION. THE FEDERAL ARBITRATION ACT, NOT STATE LAW, 
GOVERNS THE QUESTION OF WHETHER A CLAIM IS SUBJECT TO 
ARBITRATION. HOWEVER, NOTHING CONTAINED IN THIS 
ARBITRATION PROVISION SHALL PRECLUDE THE CUSTOMER FROM 
RESOLVING ANY CLAIM, CONTROVERSY OR DISPUTE IN SMALL 
CLAIMS COURT HE OR SHE OTHERWISE WOULD HAVE THE RIGHT 
TO PURSUE.

A single arbitrator engaged in the practice of law will conduct the 
arbitration. The arbitrator will be selected according to the rules of the 
American Arbitration Association or JAMS or, alternatively, may be 
selected by agreement of the parties, who shall cooperate in good faith to 
select the arbitrator. The arbitration will be conducted by, and under the 
then-applicable rules of American Arbitration Association or JAMS, as 
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applicable. All expedited procedures prescribed by the applicable rules 
will apply. Any required hearing fees and costs shall be paid by the parties 
as required by the applicable rules or as required by applicable law, but 
the arbitrator shall have the power to apportion such costs as the 
arbitrator deems appropriate.

The arbitrator's decision and award will be final and binding, and 
judgment on the award rendered by the arbitrator may be entered in any 
court with jurisdiction.

If any party files a judicial or administrative action asserting a claim that 
is subject to arbitration and another party successfully stays such action 
or compels arbitration, the party filing that action must pay the other 
party's costs and expenses incurred in seeking such stay or compelling 
arbitration, including attorney's fees.

Notices. You may get our current address for written notice by calling 
PCS Customer Service Solutions. Written notice to you is sent to your last 
known address in our invoicing records. Written notice is deemed 
delivered 3 days after deposit in the U.S. mail, postage prepaid, and 
properly addressed. Unless required by this Agreement or Applicable Laws, 
(1) you may notify us by calling PCS Customer Service Solutions, and 
(2) we may notify you by leaving a message for you on your PCS Phone, 
answering machine or with your answering service. Notice addresses may 
be changed by giving notice as provided in this section.

Choice of Law; Jurisdiction. This Agreement is governed by and must 
be construed under federal law and the laws of the State of Kansas, 
without regard to choice of law principles. You agree to submit yourself to 
the personal jurisdiction of the courts in the State of Kansas. 

General. If either of us does not enforce any right or remedy available 
under this Agreement, that failure is not a waiver of the right or remedy 
for any other breach or failure by the other party. Our waiver of any 
requirement in any one instance is not a general waiver of that 
requirement and does not amend this Agreement. If any part of this 
Agreement is held invalid or unenforceable, that part is interpreted 
consistent with Applicable Laws as nearly as possible to reflect the 
original intentions of the parties and the rest of this Agreement remains 
in full force and effect. Section headings are for descriptive purposes only 



Section 7
Terms and Conditions & Warranty Information 83

and are not used to interpret this Agreement. You may not assign this 
Agreement to any other person or entity without our prior written 
approval. This Agreement (including any referenced documents and 
attachments) makes up the entire agreement between you and us and 
replaces all prior written or spoken agreements, representations, 
promises or understandings between you and us. The provisions of this 
Agreement that are contemplated to be enforceable after the termination 
of this Agreement survive termination of this Agreement. This Agreement 
is subject to any applicable federal and state law (collectively, “Applicable 
Laws”). If there is a conflict, the Service Plan (including any Term 
Service Plan) controls over the Terms. 

The following provisions are not generally applicable and apply 
only to customers whose Service Plans include these terms:

Traveling. If you are making or receiving calls outside your Home 
Service Area but on the Sprint Nationwide PCS Network, you may be 
charged for Services at a “travel” rate for both outgoing and incoming 
traveling calls. Long distance charges may not be included in the travel 
rate. Traveling charges do not apply if you subscribe to a Home Rate USA 
plan or to both Toll-Free USA and Home Rate USA. (See Home Rate USA 
and Toll-Free USA for more information.) You do not have to register 
your Number when traveling outside your Home Service Area.

Home Rate USA. This service lets you make or receive calls from 
anywhere on the Sprint Nationwide PCS Network at your Home Service 
Area airtime rates.

Toll-Free USA. This service lets you call from anywhere on the Sprint 
Nationwide PCS Network to anywhere in the United States, Puerto Rico 
and the U.S. Virgin Islands and be charged at your Home Service Area 
airtime rates, with no additional long distance charges. If you have 
Home Rate USA but do not have Toll-Free USA, and if you make a long 
distance call outside of your defined local calling area, you are invoiced 
for the long distance charges.
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Manufacturer’s Warranty
Novatel Wireless, Inc. (“Vendor”) offers the original end user purchaser 
of the enclosed wireless personal computer modem card (the “Product”) 
from Vendor or an authorized supplier, a personal, non-transferable, 
limited warranty that during the Warranty Period the Product will be free 
from defects in material and workmanship under normal use. The 
“Warranty Period” shall be a period that expires one year from the 
original purchase date of the Product.

During the Warranty Period, if the Vendor determines that a Product is 
defective in material or workmanship, Vendor will, at its sole discretion, 
either (a) repair or replace the Product with a new or rebuilt unit (which 
unit may use refurbished parts of similar quality and functionality) or 
(b) refund the original purchase price of the Product; provided that the 
defective Product is returned to a Vendor authorized service center and is 
accompanied by written proof of purchase in the form of a bill of sale or 
receipted invoice indicating that the Product was purchased by you and is 
within the Warranty Period. After the Warranty Period, you are 
responsible for paying all parts, labor and shipping charges.

This limited warranty does not cover and is void with respect to (a) 
Products which have been improperly installed, repaired, operated, 
maintained or modified; (b) Products which have been subjected to 
misuse (including using the Products with hardware which is electrically 
or mechanically incompatible with the Products), abuse, accident, 
physical damage, abnormal operation, improper handling or storage, 
neglect, exposure to fire, water or excessive moisture or dampness, 
extreme changes in climate or temperature or environmental conditions 
not conforming to Novatel Wireless’ specification, or negligent use of the 
Products or use other than in a normal and customary manner, (c) 
Products which have been opened, repaired, serviced, modified or altered 
by anyone other than Vendor or anyone not authorized by Vendor in 
writing; (d) Products which have been damaged due to fire, flood, acts of 
third persons, acts of God, or other acts which are not Vendor’s fault and 
which the Product is not specified to tolerate; (e) normal wear and tear, 
cosmetic damage and shipping damage; (f) Products which have been 
operated outside published maximum ratings; (g) consumables; (h) cost 
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of installation, removal or reinstallation of the Product; (i) signal 
reception problems (unless caused by a defect in material or 
workmanship; (j) Products on which the original identification marks, 
warranty stickers or serial numbers have been removed, altered or 
rendered illegible; or (k) Products designated by Vendor as beta site test 
samples, experimental, developmental, reproduction, sample, 
incomplete or out of specification Products.

This limited warranty is not transferable to any third party, including but 
not limited to, any subsequent purchaser or owner of the Products. Any 
transfer or resale of any of the Products will automatically terminate 
Vendor’s warranty coverage of such Products.

This limited warranty is only valid in the United States and does not 
cover customer education, instruction, installation, set up adjustments or 
signal reception problems.

VENDOR SPECIFICALLY DISCLAIMS LIABILITY FOR ANY AND ALL 
DIRECT, INDIRECT, SPECIAL, GENERAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES OF ANY KIND OR NATURE DUE TO ANY 
CAUSE, INCLUDING BUT NOT LIMITED TO, LOSS OF PROFITS OR 
ANTICIPATED PROFITS.

REPAIR, REPLACEMENT OR REFUND, AT VENDOR’S OPTION, AS 
PROFIDED FOR UNDER THIS LIMITED WARRANTY, IS YOUR SOLE AND 
EXCLUSIVE REMEDY FOR BREACH OF THIS LIMITED WARRANTY. 
VENDOR MAKES NO OTHER WARRANTIES OF ANY KIND, EXPRESS OR 
IMPLIED, WITH RESPECT TO THE PRODUCTS, AND THIS LIMITED 
WARRANTY IS EXPRESSLY IN LIEU OF ALL OTHER WARRANTIES, 
EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION, ANY 
WARRANTY OF TITLE, INFRINGEMENT, MERCHANTABILITY OR 
FITNESS FOR A PARTICULAR PURPOSE.

To obtain warranty service for Products, please call the toll-free telephone 
number 1-888-888-9231 from anywhere in the continental United States 
to determine the location of the authorized service center nearest you and 
for the correct procedures for filing a warranty claim.
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